What’s New
or Impoved

Summary

In this chapter, you learn about:
Extended Symbol Names
Dimensioning

Text

Quickly Selecting Objects
In-Place Block/Xref Editing
Hatch Improvements
Partially Opening a Drawing

Other New Commands
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You learned about long layer names in Chapter 4. Using =Ll . i L Eot Cirert |
AutoCAD 2000, the length of symbol names (layers, blocks, ..-'q'.v . . i
text styles, dim styles, views, UCS names etc.) has been ey X _ g, Mot
expanded from 31 characters to 255. The following charac- '_u:' K , |
tersarenotallowed: < > / \ “ 1?2 * |, = - "._‘L"‘: g Compane
AutoCAD 2000 preserves and displays the symbol names i e
exactly as you type them, including uppercase/lowercase n - :
treatment. Internally, AutoCAD 2000 remains case-insensi- # e
tive to symbol names, which means you cannot create two
symbol names for the same symbol type that differ only in
case. Style List shows Description Preview shows

al Dim Stylesin compares pre- you what your

You can enable or disable extended symbol namesin a this drawing. viewed Dim dimensions will
drawing: click Tools » Options » System tab, use the Double-click on a Styleto the look like.
check box Allow long symbol names. This setting effects Dim Style to set it Current
the current drawing only. current. Right-

click on aDim
Style to rename or
delete.

Dimensioning enhancements include a redesigned
Dimension Style Manager, which uses a preview pane to

show you the effects of dimension style changes. Set Current: Highlight aDim Style in the Style

list, then click this button to make it current.
New: Createsanew Dim Style. If you highlight

ther di i oni h ts include:
Other dimensioning enhancements include an existing Dim Style before clicking new - your

e Import dimstyles from other drawings using new style will be based on that style.
DesignCenter Modify: Modify an existing Dim Style.

e The Dimension toolbar includes a new DimStyle Remember - changes here are saved to the Dim
Control pull-down list. Style and existing dimension objects using the

e New Quick Dimension and Quick Leader com- modified Dim Style

mands (used to be Express Tool commands) acces-
sible from the Dimension toolbar

e Maodify dimensions using the Properties window

Override: You can only override the current Dim
Style - if you highlight a style in the style list that
is not current, this button is grayed out. | advise
you NOT to use overrides. Instead, use the Modify
button to make permanent changes to your Dim
Styles. If you don’'t want to affect existing dimen-

(This section is purposely brief, since you have Dimension sion objects with Modify, create a new Dim Style
Wizard to create Dim Styles for you.) and Modify it.

Compare: Letsyou select two Dim Styles, then
The Dimension Style Manager window (click Format > lists all dimension variables side-by-side.

Dimension Style from the menu bar), includes a preview
that shows you the effects of changes to settings.



In Exercises 5 & 6 of Chapter 2, you learned how to use
DesignCenter to import layers and blocks into your drawing.
You can aso import Dim Styles from other drawings into
your current drawing.
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Locate your drawing in the Tree pane of DesignCenter.
Click Dimstyles in the Tree pane so that you see Dim Styles
listed in the Palette. Now just drag the desired Dim Style
from the Palette to your drawing. Remember, this loads the
Dim Style, but does not set it current. Click Format &
Dimension Style to set your current Dim Style once it’'s
loaded.

The Dimension Toolbar is useful, but it's large - try turning
it on while you' re dimensioning, then back off when you're
finished.

To quickly display the Dim toolbar, right-click on any
AutoCAD toolbar button, then pick Dimension from the
shortcut menu.

- ]
Hfbdl A FEHSme | & & [anE =| &t

Quick Leader

Quick Dimension Dim Style Control

You'll see dl of the familiar buttons from release 14, and
some new buttons as well.

New on the Dim toolbar are Quick Dimension, Quick
Leader and Dim Style Control.

AutoCAD’s Express Tools used to include a Quick
Dimension command - it's now an AutoCAD command and
has been removed from the Express Tools menu. You'll find
the Quick Dimension button on the AutoCAD Dimension
toolbar.

Quick Dimension creates multiple dimensions quickly, you
select the objects to dimension, then pick alocation for the
dimension lines.

In this exercise, we'll use the Qdim command to quickly
create the three dimension objects shown below.

1. Open Chap05Ex01.dwg.

2. If the Dimension toolbar is not visible, right-click
on any AutoCAD toolbar button, then pick
Dimension from the shortcut menu.

Click the Quick Dimension " toolbar button.

At the Select
geometry to
dimension
prompt, pick the
three lines shown
here, then press
Enter.

>

Select these

5. At the Specify dimension line position, or
[Continuous/Stagger ed/Baseline/Or dinate...
prompt, type B<Enter>.

This puts you in the baseline mode (baseline
dimensions share a common datum point).
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1. Open ChapO5Ex02.dwg.
2. If the Dimension toolbar is not visible, right-click

on any AutoCAD toolbar button, then pick

Dimension from the shortcut menu.
As you drag your mouse to the left, notice the Click the Quick Leader * toolbar button.
ghosted image showing an outline of what the - _
dimensions will look like. 4. At the Specify first leader point,... prompt, press

] ) i ] Enter on the keyboard to accept the Settings
Pick a point on the screen to locate the dimensions. default.
WEe're not done, since the middle dimension is | beades Gettiogs L
actually not dimensioning the correct upper point. e e
Let's use grips to modify the second dimension...
Arrudobr. Ty

Use grips to stretch — :
point P1 to P2 (the P2 e
endpoint of the hori- | / — Bk, Fedeaarcn Arrvcsion s
zontal construction 1 ¥ '..--- < Ham d :--* 3
line). Use object snap ' T
so it's accurate. _
Thisexerciseillustrates =
how Qdim might not = — =
initially locate dimen- l |
sions exactly where
you want them, but it's often easier to get the 5. Inthe Leader Setting dialog, Annotation tab, select

dimensions on the screen quickly with Qdim, then
modify them afterwards.

Your drawing should look like the example shown
at the beginning of this exercise.

In this exercise, you'll use the Qleader command to quickly

create straight-line and curved leaders.

None for the Annotation type. (This drawing
already has text, we're only drawing leaders.)

beades Settings L

A -eaded Lt 1 fewen

You can use Qdim to create continuous, staggered, Lo Lins Wmnaad

baseline, ordinate, radius and diameter style dimen- : ::::’ —p— =

sions - use the appropriate keyword option to

change the style, as you did in step 5. R PRIl

Moy Lot N R e T TR ] b
This completes Exercise 1. Close Chap05EX01.dwg, dis- - Poamdlomst bnride  x
card changes.
i | Ll Fsin

6. Inthe Leader Line & Arrow tab, select Spline for
the Leader Line, in the Number of Points area,
uncheck No Limit, enter 4 for Maximum.
Arrowhead should be set to Closed filled and both
angle constraints should be set to Any angle.

Like Quick Dimension, Quick Leader has been moved from
the Express Tools menu to the AutoCAD Dimension toolbar.

By customizing your Qleader settings, you can quickly cre-
ate leaders in straight-line or spline format, text or no text,
arrowhead type and more.
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Click OK to exit Leader Settings.
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Continue with the Qleader command - make your
drawing look like the example above.

Tips:
e Your first point picked is at the arrowhead end
of the leader.

e Your settings specify 4 points for each leader.
Once you pick the 4th point, the Qleader com-
mand stops and your leader line is created.

e Don't worry about making the leader look per-
fect thefirst time. Get the leader placed, then
use grips to adjust the vertices later, if neces-
sary.
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Using Settings in the Qleader command, you can
select the arrowhead type. Choices include closed
filled, dot, integral and user arrow, which you could
use to make a loop-end leader.

This completes Exercise 2. Close Chap05Ex02.dwg, dis-
card changes.

Modifying Dimension Properties

Using AutoCAD’s new Properties Manager and the Dim
Style Control on the Dimension toolbar, it's very easy to
modify existing dimensions. The examples below show
before and after the changes you'll make in the next exer-
cise.

Before: We'll use Properties Manager and the Dim Style
Control on the dimension toolbar to modify quickly
these leader lines

After modifying the leader lines

Exercise 3 - Using Modifying Dimensions

Remember that leaders are dimension objects, that is they
use Dim Stylesjust like dimensions do. The techniquesin
this exercise can also be applied to dimension objects.

1. Open ChapO5EX03.dwg.

2. If the Dimension toolbar is not visible, right-click
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on any AutoCAD toolbar button, then pick 1t s - Chuae
Dimension from the shortcut menu. — 7l
In your drawing, see the pair of leaders at the Mphaesc  Categorced
“RAS/WAS..."” annotation - currently they have the v
. - ] [ JER
wrong arrowhead type and size, and they’re the L e
wrong color. Tt R -
3. Usethe LIST command, select one of the =y e
“RAS/WAS...” leaders. Here'swhat LIST says: e S LA
dimension style: "D-1_10$7" L W VL WA
dimension style overrides: u:; .
DIMLDRBLK Open30 e A Cosed Ml
DIMSCALE  3.00 o | s
T e T
4. Select both “RAS/WAS...” leaders. (See example o | W -
below.) T s 7o _:;:.’... . e
Specie e coles o =":
™
AW %A FE M- T m s a F ;“""“ |
hafoits |

7. If they're not still selected, select the 2 leaders.
Click Other from the Dim line color pull-down
list in the Properties window.

8. Inthe Select Color dialog, enter 11 for the color
value, then click OK.

5. On the Dimension toolbar, pull down the Dim Style 9. Press Esc on the keyboard twice to de-select the
control and select D-1_10 from the list. (This draw- leaders. Asyou see, their color has been easily
ing will be printed at a 1:10 scale, that's why changed using the new Properties window.

you're picking the D-1_10 style.) You have just set
the selected leaders to the D-1_10 style and cleared
the leaders of all overrides. Usethe LIST com-
mand, select one of the leaders, you'll see there are
no longer overrides controlling these dimensions.

This illustrates how you can use the Dim Style con-
trol on the Dimension toolbar to change the style of
adimension or leader object.

To make the “RAS/WAS...” leaders match the After
example, we still need to change their color. We
cannot simply change the color value of the |eader
like we would aline or circle. Leadersand
Dimensions behave differently. Continue with step
6 to change their color...

6. Click the Properties button £ on the Standard
toolbar.
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10. Select both home-run leaders (shown Proqs-tics  Chaglstsd T
at the right, highlighted), then usethe 1 9
Dlm line color pull-down to change —
their color to yellow. T
i ks B BLope
11. Press Esc on the keyboard twice to de- Liryes ]
select the leaders, then select both T as TR
magenta colored secondary arrow- o e — . L
heads on the home-run leaders. | el ' a h n
12. Change the selected arrowheads color e g Moo
to yellow by using the Color pull- g - H ~ 1 .
down in the Properties window, then lLives & Arrows -— )4 | J
press Esc twice to de-select the arrow- iy e — .
heads. i b Lk Dot f
= T ; [ a
::::;l':l: E?‘H "!a h—- a |7 P J:
mhmn‘hh:nd" ; - o
13. Select both “2#12..." leaders (shown at e
the right, highlighted), then select User SRR -
arrow from the Arrow pull-down. — =l X
Aphubstic  Caingoazed
14. From the Select Custom Arrow Block 5 teecrd
dialog, select ZLPARW (loop-end o e
bIOCk), then click OK. ::Iﬁ: — | il
15. Press Esc on the keyboard twice to de- i i 2
select the leaders. Hiyparial
[ 1 .
You drawing should look like the After o S oo i {:.l h :
example shown earlier in this chapter. T W ~ A
17 Laresd i e s - UEDERE = f 1T | J
e Dofosilied R £ T £
;’:l._i-' Ez :w.:u.-l- 5 -
. ) Do b comon 1 &
This completes Exercise 3. Close [ Test R s el
) Taek odfoar A Do Lrarein
Chap05Ex03.dwg, discard changes. Bt ps et (Cps——r o |_ Mt
|OF iegrad 4
S e e of B[ 0 N
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Multiline Text (Mtext) enhancements to AutoCAD
2000 include:

e AutoCAPS option always uses uppercase,
regardless of your keyboard caps lock setting

e Resizable Mtext editor dialog

e Fraction features include automatic stacked, archi-
tectural-style, alignment control (top, middle, bot-
tom), scale relative to text height

e Case override, and new Combine Paragraph option
available from shortcut menu

e Most recently used fonts displayed in pull-down
list
e Adjustable Line spacing

e Faster: display of Mtext dialog, object snap detec-
tion, text importing, generation of Mtext

Complete the following exercise to learn about the new
Mtext features.

1. Open ChapO5Ex04.dwg.
2. Make sure keyboard Caps Lock is OFF.

3. Click Draw > Text » Multiline Text from the

menu bar, or click the Multiline Text button
from the Draw toolbar.

Moy chaecis oo

COFSEHT SR HF FLA [SOE | T | ACOCSSCFES| TISMED B
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4. Pick two cornersin the empty area at the bottom of
the schedule (shown above).

5.

10.

11

Lra “pucwgy | FedPades i
w| O11E = 1] - | EREEE w|  Garebdd T carca
o e
Hal:
LaliCd

E

As you move your mouse pointer over any cornerJ
of the Mtext dialog, notice the pointer changes

shape - it appears as a double-sided arrow. Drag

the corner of the dialog by clicking and holding the
left mouse button.

The ability to resize the Mtext dialog is new to
Release 2000

In step 2, you turned your keyboard caps lock off.
Type some text into the Mtext editor - it should be
lowercase.

Double-click on AutoCAPS near the lower right
corner of the Mtext dialog. With AutoCAPS now
on, type more text into the editor. It should be
uppercase.

When you exit the Mtext editor (don't exit now),
your keyboard caps lock will be off, just like before
you used Mtext. When you return to the Mtext
command, since AutoCAPS is on, new text you
enter will be uppercase.

Enter the following into the Mtext editor: 1 1/2”

Asyou press [T i L
the " key, the Uiz pos wvind o dost ot ey iect e et
AutoStack e e e

i ) - = Lol fadaTisching
Properues dia Ea.., T ————
log is present- iy hom s shou] ek

ed. € Lot i B s hagoral Facfan

(=S R R T

If you check

the “Don’t L e A s s
show this dia- | ——
log again...”

option,

AutoCAD will stack fractions without asking.
Also, you can choose horizontal or diagonal for-
mat.

Change your settings to match those shown above,
then click OK to exit the AutoStack Properties dia-
log.

Enter another fraction into the Mtext dialog, for
example 15/16” - it should automatically stack.
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12. Highlight 15/16. (To highlight EEE==T=
text, drag your mouSe across it D st | Lna Space | e

3. IntheLine Spacing

tab of the Mtext Crawacis Propass: Lk Saiied | Frd ®agpecs

while holding down your left ¥ R =] e editor, changethe e msong |Ewacty = (13011 R =
mouse button.) " Linespacing set- |51 °
L H = _—
13. Right-click over the highlight- ., P Exadly  |"ums2’
ed text and select Properties. coen e M
:_;u (We know each MM 54
g Cick v line in the schedule
et is 0.300 inches Mol cha s prosiran
o= apar)
Coarars Parsgp e
4. Enter the following text:
"MMSL"
14. The Stack _ o “MMSZ
Properties alows o 5 F_]" MMS3
you to change text, ... Tt "MM 4"
style, position and . ) 5. Click OK to exit the Mtext editor. WARK
size. Sl Y Facbon [aapna] = Doteuhs . . .
: 6. Sincethetext istop/left justified, |
= i w aiteS ek . . HHEI
15. Click OK to exit e it's too high and up against the left
Stack Properties. it side of the schedule. Movethetext — [MMSZ" |

down and to the right to better cen- RTIT R

ter it in the schedule lines.
16. Click OK to exit the Mtext editor. .
7. Copy thetext you just created to the

next column (Equipment Served).
Use object snaps so it's accurately placed.

This completes Exercise 4. Leave open Chap05Ex04.dwg
for the next exercise.

8. Right-click on the new text (the copy), then select
Mtext Edit from the shortcut menu.

Exercise 5 - Mtext - A Schedule Using the New 9.
Line Spacing Feature

Change the text to match the Equipment Served
column in the completed schedule shown below.

This exercise uses the new Mtext Line Spacing feature to
fill in a schedule.

i LMD STARTER INTERLOCH
1. Usethe drawing from the last exercise, EQUPWEHT SERVED| HP | FLA [S2E | T#PE | ACCESSORES| STARTED B
Chap05Ex04.dwg, start the Mtext command by [ Wms1” [ "crwer” 1% 0| @ |rann| mosspac | atc
clicking Draw & Text & Multiline Text from the [ WSz [ Crwpz” 1% B0 | |PunR| HOARPAC | ATC
menu bar, or click the Multiline Text button 4 [ MNS" | THMP L 4210 |FVHR| HOARPAC | ATC
from the Draw toolbar. unss" | Hwez” 1 420 [Poe|HosERAC | ATC
2. Pick two cornersin the
MARK column, indicated A LowD 10. If time permits, complete the schedule as shown.
ECLWPMENT SERVED
here b.y PL gnd P2 .Use P1? This completes Exercise 5. Close Chap05Ex04.dwg, dis-
endpoint or intersection
osnaps to make the picked card changes.
points accurate.
J_I.
*py
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Find & Replace Text L recl s mplece P
Fra bl i R
AutoCAD 2000 introduces the Find feature, which provides 1 T IR &
you with a quick and easy method for finding and replacing e =l oo
text within a drawing file. You can use the Find tool to e
locate single line text, multiline text, text in block attributes,
dimension annotations and hyperlink/URL names. The L
Zoom option enables you to locate and zoom to the text in = [3
the drawing file. Options include match case and find
whole words only, as well as search the entire drawing or a
selection set.
Exercise 6 - Find & Replace Chua T
1.  Open ChapO5EX06.dwg. el
2. Right-click over theAutoCAD | =2 .. 7. Inthe Find text string box, type AV
graphic screen (where you draw | - Fus 8. Inthe Replace with, type AVE
objects), then choose Find from ’ ® P
the shortcut menu. e 9. Notice Search in isset to Entire drawing. If you
select objects before starting Find, you can change
il the Search in option to Current selection, or sm-
ek 3okl ply press the Select objects button _&|. Leave
Crmors s Search in set to Entire drawing for this exercise.
10. Click the Replace All button.
BTN M=
Fired bk s Samchiby A result message at the bottom of the Find dialog
L - - - should tell you that 26 replacements were made.
Fopdaon vy
o fekes 11. Click Close to exit Find.
S aach rande
Gonindl A | This completes Exercise 6. Close Chap0O5Ex06.dwg, dis-
Flmises card changes.
Haphacs A1

If you've ever used the AutoCAD Filter command to find

el e and select objects, you should find the new Quick Select
easier and faster to use, though it can be a bit confusing.

3. Inthe Find text string box, type university, then

dlick the Find button. Using Quick Select, you can find and select objects based

_ o on type and/or property (color, layer, etc.). You can com-
4, _In the Context window, see the word Unl_versty. If bine searches, for instance select all lines on layer Topo, and
It were part of a longer sentence, that entire sen- all Polylines on layer Topo, by completing one search, then

tence would show up here. , . ;
using the Append to current selection option.
5. Click Zoom to, which causes AutoCAD to zoom to

the text it found. You may have to move the Find Exercise 7 - Quick Select
dialog around the screen to uncover the text. In this exercise, you' Il use Quick Select to find and select all
6. Click Fint Next, then Zoom to. AutoCAD zooms Polyline objects on the C-TOPO-5 layer, so that we can

to a second occurence of text with university. change linetype scale of those objects.



1. Open Chap05Ex07.dwg.

2. Right-click over the AutoCAD graphic screen
(where you draw objects), then choose Quick
Select from the shortcut menu.
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3. Usethefollowing settings in the Quick Select dia-
log:
Apply to: Entire drawing
Object type: Polyline
Properties. Layer
Operator: = Equals
Value: C-TOPO-5
How to apply: Includein new selection set

Append to current selection set: Unchecked
4. Click OK.

H 4 F H i1 []

Your drawing should look like the example above.

6. Usethe Properties window to change the linetype
scale of the select polylinesto avalue of 1.2.
(Remember Chapter 4, Exercise 2?)

This completes Exercise 7. Close Chap0O5Ex07.dwg, dis-
card changes.

AutoCAD’s new Refedit command allows you to edit refer-
ence geometry and the current drawing at the same time.
Use it to select block or external reference objects and edit
them from within the context of the parent drawing, i.e., in
place. You also have the capability to copy objectsin the
reference drawing into the parent drawing as well as copy
objects from the parent drawing into the external reference.

An additional benefit of this feature is the ability to edit the
definition of a block without exploding it. With Refedit,
you can select a block within a drawing, edit its definition,
and save it. Once you have saved your changes, all
instances of that block in the drawing file will automatically
be updates with your change.

In this exercise, you'll use Refedit to solve a common prob-
lem. You'll open a sub-shest, E2, which uses an external
reference, X-Topo. In E2, the topo lines need to be dis-
played in color #42, which is a 50% screened O pen. The
problem is, the topo lines drawn in X-Topo where created
with a color of White, instead of Bylayer. Therefore, in E2,
when we assign color #42 to all X-Topo layers, those lines
stay white. Rather than open X-Topo, we'll use Refedit to
modify the topo lines, changing their color to Bylayer.

1. Open ChapO5EX08.dwg.

Asyou can see, the topo lines are white in color. If
you check the layer settings, all X-Topo layers are
color 42.

2. Type GLR<Enter>. Select one of the white topo
lines. The GLR command give us the following
information:

Select object:
Lwpolyline: color=White, linetype=Bylayer
Layer: "X_topo|s-topo-1"

Notice the color is White, not Bylayer like it should
be.
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3. Turnonthe Refedit EE—]

toolbar: right-click -4 W0
over any AutoCAD

toolbar button, then select Refedit from the shortcut
menu.

4. Click the Edit block or xref button “# on the
Refedit toolbar.

5. At the Select reference: prompt, pick on one of the
topo lines to select the X-Topo external reference.

6. Inthe | eclorreced
Reference Admmus raes Fisma
Edit dialog, B w_1oF0
click OK to
accept the
defaults.

Having

checked the  rwv wwpens

Enable  FOSmNTINT

unique layer

andqwmbilal e =
names simply

means that the X-Topo layers will begin with a $#$
while you're editing this xref. For example, the X-
Topo layer Topo-1 will appear as $0$S-TOPO-1,
until we're finished editing it. If there were a
TOPO-1 layer in this drawing (Chap05Ex08.dwg),
it would remain separate from the $0$S-TOPO-1
layer of the xref.

7. Atthe Select nested objects: prompt, select all
objects using awindow. As an alternative, you
could select only those objects you need to edit, but
for this exercise, select al objects.

ulrnllll;dn.l-ﬂg-o._ﬂ- .,' - .l B

As shown here, using Refedit, you can direct-
ly edit the objects of an Xref without opening
the Xref in a separate drawing window.

Click on one of the objects of the xref. Natice you
can select object one at atime.

8. Select all objects again using a window.

Fla Bl s lest Fomsdd Tesk [ves Ceeraan dhdly Windos Fgasx AFS
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9. Usethe Color Control pull-down (show above) to
change the color of the selected object to Bylayer -
or use the Properties window if you're more com-
fortable with that method.

10. Click the Save back changesto reference button
% on the Refedit toolbar.

11. Click OK to savethe raran n
reference changes. R T SRR L p—]
A
T v reer ool b, clach, O
- TG the D, (i Caniel
The topo lines should now =] oo

appear in color 42.

This completes Exercise 8. Close Chap05Ex08.dwg, dis-
card changes.

Bonus Exercise 9 - Use Refedit to modify a block

You can also use Refedit to modify a block definition. For
instance, if you had a drawing with a block depicting atree
in plan view, and this drawing had 100 instances of this tree
block inserted, you could use Refedit to modify the tree
block. You might want to change the tree block, so that
instead of using many lines, it could be drawn using two or
three simple circles. When you save the changes, all 100
instances of the tree block would be updated.

1.  Open ChapO5EX09.dwg.

2. Usethe Refedit command to modify the .
tree shown here. Make the new tree look
like anything you want - maybe a ssimple
circle or two.

Use the same procedures as in steps 3 - 11 of exer-
cise 8.
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3. When you save your changes, all instances of that
tree should have changed.

This completes Exercise 9. Close Chap05Ex09.dwg, dis-
card changes.

Hatch

The Boundary Hatch dialog in AutoCAD 2000 has under-
gone aredesign to enhance productivity. It now presents the
hatching parameters in two tabs: Quick and Advanced. A
hatch preview is available from aright-click shortcut menu
enabling you to check settings while picking hatch points or
objects. In addition, you can now preview custom hatch
patterns using the Swatch feature.

sy ik LE
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T
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Quick tab of the redesigned Boundary Hatch
dialog

Double-click on the Swatch image to view a hatch pattern
palette, which allows you to visually select predefined and
custom patterns.
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Advanced tab of the redesigned Boundary
Hatch dialog

In the Advanced tab, you can select island detection style,
object boundary settings, boundary set and island detection
method (flood works well for most hatching, and includes
islands as boundary objects).

Exercise 10 - Boundary Hatch

The goal of this exercise isto use boundary hatch to com-
plete the earth hatching as shown below:

1. Open ChapO5Ex10.dwg.
2. Click Draw > Hatch from the menu bar.

3. Inthe quick tab of the Boundary ¢ ... ™

Hatch dialog, click on the swatch of
image.

4. Select the Earth pattern in the Other Predefined @
tab, then click OK to exit the palette. il
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Enter 16 for the scale. BTN Xlxl

6. Click Pick Pointsin the Boundary Hatch dialog. e e S
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In the View geometry to load area, you can select
7. Pick apoint in each of the 5 high- P Extents (all objects not on frozen layers), Last (the
lighted areas shown above. [T last display of the drawing), or user created views.
) ] ) E— For this exercise, you'll use select geometry to load
8. R|ght'CI|Ck, then select Preview. it based on |ayer
Notice this shortcut menu also e
includes an undo option and iSland . suws s pessrics 5. Imagine you need to view only the contour geome-
detection modes. f""‘ ';"j::‘ try in this drawing - click the check box beside the
_ N = = 5-10-CONTOURS layer, then click Open.
9. After confirming the preview, right- m _
click to return to the Hatch dialog, 6. A zoom extents may be necessary, but the partially
then click OK to create the hatch. loaded drawing should contain only objects on
layer 5-10-COUNTOURS. This 16 megabyte file
This completes Exercise 10. Close Chap05Ex10.dwg, dis- would take much longer to open it its entirety.
card changes. 7. Topartialy Ml 1E]
load additional | T -
geometry, click
File » Partial

Ea[“a| Qpen & | Qad Load.

8. Check the Flora

Using AutoCAD 2000's new Partial Open feature, you can |layer, then click |
open a portion of a drawing and external reference file, OK.
based on saved views, or based on layers. Since only the 9. Zoomin if nec-
needed portion of a drawing is loaded, memory require- essary to verify
ments and opening times are reduced. Once you have par- that objects
tially loaded a drawing, additional portions of the file can be from both lay- : 5
|loaded with the Partial Load feature. ers are now DR T, 14] | )
available.
Note: You cannot use Partial Open with arelease 14 or earli- ) ) i
er drawing file. This completes Exercise 11. Close ChapO5Ex11.dwg, dis-
card changes.
Exercise 11 - Partial Open & Load
1. Click File » Open, or click the Open button on the
Standard toolbar. If you print a partially opened drawing using
2. Inthe Select File dialog, highlight AutoCAD’s print command, only the loaded
Chap05Ex11.dwg, but don't double-click or press geometry will print. If you print a partially opened

the Open button. drawing using CADNET PrfGenerator, ALL objects
will print as if the drawing was fully opened.

3. Click Partial Open.



Have you ever tried to open a drawing file from the net-
work, only to receive a message from AutoCAD stating that
the drawing was currently in use by another user?

Using the new WHOHAS command, you can sometimes tell
who has afile open (if that user is working in AutoCAD
2000, and has WHOHAS installed).

1. Open Electrical Prototype.dwg.

2. Type WHOHAS<Enter> at the AutoCAD com-
mand prompt.

3. Inthe Select drawing to query dialog, select
Electrical Prototype.dwg, then click OK.

4. Something similar to the following should be dis-
played:
Command: whohas
Owner: Bruce Littlehorn
Computer's Name : NP2000010313

Time Acessed : Thursday, February 24, 2000
9:25:44 PM

Beware - | have found that Whohas doesn’t always
work - it sometimes reports that no owner informa-
tion is available when there should be.

This completes Exercise 12. Close Electrical Prototype.dwg.

Using AutoCAD 2000's new Revert command, you can
open a drawing file, make modifications, then change your
mind and use the Revert command to re-open the drawing
file as it was before your changes. To use Revert, type
REVERT<Enter> at the command prompt. AutoCAD will
ask you to confirm that you wish to abandon changes.
Remember, once you make changes to a drawing file and
save those changes, you cannot use Revert to undo those
changes.

This completes Chapter 5.



